Analysis and Visualization of Dynamic Networks using the DyNet App for Cytoscape

<table>
<thead>
<tr>
<th>Journal:</th>
<th>Current Protocols</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manuscript ID</td>
<td>CP-18-0092.R1</td>
</tr>
<tr>
<td>Wiley - Manuscript type:</td>
<td>Protocol</td>
</tr>
<tr>
<td>Date Submitted by the Author:</td>
<td>n/a</td>
</tr>
<tr>
<td>Complete List of Authors:</td>
<td>Salamon, John; SAHMRI - South Australian Health and Medical Research Institute, Infection &amp; Immunity Goenawan, Ivan; SAHMRI - South Australian Health and Medical Research Institute, Infection &amp; Immunity Lynn, David; SAHMRI - South Australian Health and Medical Research Institute, Infection &amp; Immunity</td>
</tr>
<tr>
<td>Keywords:</td>
<td>network biology, Cytoscape, DyNet, Dynamic networks, visualization</td>
</tr>
</tbody>
</table>

Abstract:
Biological processes are regulated at a cellular level by tightly controlled molecular interaction networks, which are collectively known as the interactome. The interactome is not a static entity, but instead is dynamically reorganized or "rewired" under varying temporal, spatial, and environmental conditions. Most network analysis and visualization tools have, to date, been developed for static representations of molecular interaction data. Here, we describe a protocol that provides a step-by-step guide to DyNet, a Cytoscape 3 application that facilitates the visualization and analysis of dynamic molecular interaction networks. DyNet represents a dynamic network as a set of state graphs which are synchronized in their layout. This synchronization is managed in real-time and is automatically updated when a graph is manipulated by a user (e.g. dragging, zooming, moving a node). DyNet also provides several statistical tools enabling users to quickly identify and analyze the most 'rewired' nodes across many network states.
 TEMPLATE for PROTOCOL UNIT:

Current Protocols in Bioinformatics

Analysis and Visualization of Dynamic Networks using the DyNet App for Cytoscape

John Salamon\textsuperscript{1,2}, Ivan H. Goenawan\textsuperscript{1}, David J. Lynn\textsuperscript{1,2,*}

\textsuperscript{1}EMBL Australia Group, Infection and Immunity Theme, South Australian Medical and Health Research Institute, North Terrace, Adelaide, South Australia 5000, Australia.

\textsuperscript{2}College of Medicine and Public Health, Flinders University, Bedford Park, South Australia 5042, Australia.

Contact information:
\texttt{john.salamon@sahmri.com}
\texttt{ivanhg93@gmail.com}
\texttt{david.lynn@sahmri.com}
Significance Statement

This protocol provides step-by-step instructions on the use of DyNet, a Cytoscape application for the analysis and visualization of dynamic molecular interaction networks. DyNet allows multi-state dynamic networks to be explored in a highly effective manner that preserves node position across multiple networks, enabling researchers to easily identify highly rewired nodes and other network features with high statistical variance.

ABSTRACT

Biological processes are regulated at a cellular level by tightly controlled molecular interaction networks, which are collectively known as the interactome. The interactome is not a static entity, but instead is dynamically reorganized or “rewired” under varying temporal, spatial, and environmental conditions. Most network analysis and visualization tools have, to date, been developed for static representations of molecular interaction data. Here, we describe a protocol that provides a step-by-step guide to DyNet, a Cytoscape 3 application that facilitates the visualization and analysis of dynamic molecular interaction networks. DyNet represents a dynamic network as a set of state graphs which are synchronized in their layout. This synchronization is managed in real-time and is automatically updated when a graph is manipulated by a user (e.g. dragging, zooming, moving a node). DyNet also provides several statistical tools enabling users to quickly identify and analyze the most ‘rewired’ nodes across many network states.

Keywords: DyNet, Network Analysis, Cytoscape 3, Dynamic Network

INTRODUCTION

Molecular interactions between genes, proteins, and other molecules form complex systems which can be significantly altered under different temporal and spatial contexts (Barrios-Rodiles et al., 2005; Przytycka et al., 2010). Network analysis approaches provide a means to model and investigate these systems of interactions by representing them as a mathematical graph, in which the interacting partners are represented as linked nodes. Understanding how rewiring occurs within these networks is necessary to understand how dysregulation of molecular interaction networks are associated with disease (Barabási et al., 2011; Bowler et al., 2015). Despite the power of network representations, the dynamic nature of these systems provides a challenge when attempting to differentially visualize networks of cellular interactions across different states.

To facilitate improved dynamic network visualization and analysis, we have released DyNet (Goenawan et al., 2016), a Cytoscape application that provides many features for the visualization and synchronization of large, dynamic cellular networks. DyNet simultaneously synchronizes the layout of multiple networks, such that the positions of the nodes are kept the same within each network, even when node positions are manually modified. Multiple statistical tools are provided to facilitate network comparisons, including a rewiring metric, the

John Wiley & Sons
$D_n$-score, for identifying the most rewired nodes, and $\log_2$ fold-change comparisons of any numeric edge and node attributes.

**BASIC PROTOCOL 1: INSTALLATION, LAUNCH, AND USAGE OF DYNET**

Introductory paragraph

Static networks represent a snapshot of molecular interactions in a given state – but in order to compare multiple cellular states and identify network rewiring, multiple networks must be simultaneously compared. This can be accomplished using DyNet, a software package developed for Cytoscape 3 that enables users to compare any collection of networks within Cytoscape.

**Necessary Resources**

**Hardware**

Any Windows, MacOS, or Linux system capable of running Java 7+. A desktop computer with at least 8GB RAM is recommended. However, memory use will scale with network size.

**Software**

Java 7+, Cytoscape 3.2+, (Shannon et al., 2003) and DyNet (Goenawan et al., 2016). See support protocol 1 for installation details.

**Files**

The user must provide multiple networks to be analyzed by DyNet. DyNet is capable of finding corresponding network components (i.e. nodes/edges) between multiple different networks as long as they share some identically-named attribute. The demonstration files used in this protocol are provided as XGMML files at


**Protocol steps—Step annotations**

Please note that all figures in this protocol were produced from DyNet running on MacOS Sierra (10.12.6), using Java 8 and Cytoscape 3.5. Depending on the platform in use, the appearance of DyNet and Cytoscape may differ from the screenshots presented here.

**Initialize DyNet**
1. Launch Cytoscape 3.2+ as described in the protocol “Biological Network Exploration with Cytoscape 3” (Su et al., 2014) and install DyNet as described in Support Protocol 1 (see below).

2. Import the networks you wish to use with DyNet. This can be accomplished by either using Cytoscape’s inbuilt import feature (File → Import → Network → File), or by using DyNet’s multiple network import feature (Apps → DyNet Network Importer). If Cytoscape’s importer is used, users must ensure networks are imported into separate collections (When prompted to choose the Network Collection, select “Create new network collection”).

3. Click on the “Apps” menu

4. Select “DyNet Analyser”

The DyNet initialization dialog will now appear, which allows you to choose which networks should be included in the analysis and provides options for how DyNet should interpret them (Figure 1).

5. Select each network that you wish to be included within the analysis by left-clicking the network name from the list on the left side of the dialog (Figure 1A). Use control + click (command + click on MacOS) to select multiple networks at once.

6. Under “Initial layout”, choose an algorithm to be used for the initial layout of all networks (Figure 1B). This can be changed later.

7. Select whether networks should be treated as directed or undirected networks under the “Treat networks as:” heading (Figure 1C). If the “Directed networks” option is selected, DyNet will consider edges which link the same nodes but have opposing directionalities to be separate edges.

8. Click on the “Advanced options” label to expand the dialog (Figure 1D).

9. Under “Advanced options” (Figure 1D) select all attributes that DyNet should use to determine whether network components (i.e. nodes/edges) in different networks represent the same corresponding node/edge in different states.

This advanced options selection allows you to exclude nodes and edges by adding more parameters that must match for a node or edge to be considered corresponding. For example, you may have networks with nodes containing attributes for both “name” and “species”. If you select both of these attributes, DyNet will not consider nodes to be corresponding unless both “name” and “species” of both nodes match. DyNet stores a one-to-one mapping of corresponding nodes and edges in the different networks, so ensure that there is only one unique node/edge in each network which has the same combination of values for all selected attributes. DyNet will be unable to analyze or synchronize nodes/edges that cannot be matched across different networks.
10. Select “OK”.

DyNet will now generate a reference network (called the “DyNet Central Reference Network”) which contains the union of all selected networks. The original networks used to generate the union will then have their layouts synchronized, with nodes and edges placed in the same spatial position as in the union network. If a node/edge is moved in one network, it will be moved to the same position in all other networks.

11. In versions of Cytoscape prior to version 3.4, DyNet will automatically tile the network view windows, allowing you to see all of the networks simultaneously, as seen in Figure 2. If you are using a version of Cytoscape <3.4, please skip to step 15. Otherwise, follow steps 12-14.

12. Select the “Show grid” button (Figure 3A) to display all networks in grid mode.

13. Select all the networks you wish to display simultaneously from the grid view (Figure 3B). Hold shift or control (command on MacOS) to select more than one at a time.

14. Press the “Show view” button (Figure 3C) to tile all selected network visualizations. All selected network visualizations will now be shown simultaneously.

15. Click and drag any node(s) within any network and observe that the other networks are simultaneously updated to reflect this change.

16. (Optional) If the network is large, Cytoscape may automatically reduce graphics details at low zoom levels. You can disable this behavior by selecting “View → Show Graphics Details”, but Cytoscape may become less responsive.

All selected networks are now synchronized by layout, meaning that if the user is to manually manipulate the positions of nodes in any of the networks, all other networks will be modified to reflect this change in real-time.

17. (Optional) If using an older machine, you may wish to deselect the synchronisation options under “Network-View Synchronisation Settings” in the DyNet control panel (Figure 4) to reduce the computational load.

**Pairwise network comparison**

DyNet’s pairwise network comparison feature allows users to easily identify differences between two networks. The union network will highlight the node/edge changes between the two networks, with one network assigned red, the other green. The default difference highlighted is the presence or absence of nodes between the two networks (Figure 5), but pairwise comparisons can be made between any Boolean or numeric node/edge attribute. Pairwise comparison is automatically enabled when only two networks have been selected in DyNet.
When the attribute used for pairwise comparison is numeric (as opposed to a true/false Boolean value), node size and/or edge thickness within the original two networks is mapped to the attribute values. In the DyNet Central Reference Network, component size/thickness will be mapped to the log₂ fold-change between the two networks. These log₂ fold-change values can be found in Cytoscape’s node and edge tables, so that they can be used for later analyses if desired. The node and edge tables are found at the bottom of the Cytoscape window, or if hidden, may be shown by selecting View → Show Table Panel. Calculation of the Log₂ fold-change will only work correctly with positive numbers, so ensure that no attributes contain negative numbers.

18. Under the “Pairwise Network Comparison” menu (Figure 5A), specify the two networks that you wish to compare. Nodes/edges will be colored red/green depending on your selection (Figure 5B). White nodes/edges represent those that are common to the two networks.

19. Tick the “Highlight node changes” and/or “Highlight edge changes” boxes to enable pairwise comparison highlighting nodes and/or edges that differ in the 2 networks.

20. To compare only node/edge attribute differences between the 2 networks and not the presence or absence of network components, check the “Only highlight common but attribute-varying nodes/edges” box.

21. To investigate a single node of interest in more detail, right click on it within the DyNet Central Reference Network, and choose “Apps → DyNet Node Analyser” (Figure 6). This highlights the selected node, its edges, and direct neighbors, while other components will be rendered transparent (Figure 7A).

22. Exit the node analyser mode by selecting Exit Node Analyzer from the panel to the left (Figure 7B).

DyNet analysis of more than two networks

When comparing many different network states, it may be desirable to identify components that have been most altered. To meet this need, DyNet enables the identification of network components with the highest variance for a particular attribute across multiple networks. The most variant components are highlighted in the darkest shade of red, and all other components are assigned lighter shades appropriate to the magnitude of their variance. This feature will work with either Boolean or non-negative numerical attributes.

As different nodes and edges might have a wide range of attribute variability, the calculation of variance is only made after normalization of attribute values. This normalization is performed by dividing each attribute value with the average across all networks, ensuring the analysis provides a better reflection of how far values deviate from the average, rather than only identifying components with larger values.
23. Under the “Multiple Network Analysis” menu (Figure 8A), select the networks to be included for analysis.

24. Tick “Highlight most varying nodes” and/or “Highlight most varying edges” to enable analysis of nodes and/or edges.

25. Choose which attributes will be used for the analysis under the “Node property” and “Edge property” selection boxes. These attributes could, for example, be node or edge weights, or you may choose the “DyNet REWIRING” attribute which will highlight the nodes which are most rewired across different networks.

All network views are immediately updated to reflect your changes. The multiple network analysis will color nodes from low to high variance in white to red, and edges from grey to red, where red represents the largest variance. Network components with variances of more than two standard deviations away from the mean variance of all nodes/edges will automatically be assigned the most extreme red coloring, while color assignment to values within the two standard deviation range will be scaled linearly according to their variance.

Node rewiring analysis

DyNet features the ability to highlight nodes with the most varying edge connections between the different networks, aka the most “rewired” nodes. DyNet’s dynamic neighborhoods score (the $D_n$-score), captures the change in node connectivity, across networks. It can identify the most rewired nodes in different networks even if the node degree or the sum of surrounding edge weights remains constant.

To calculate the rewiring score, each node in every network is represented as a vector with multiple components representing an edge attribute/weight. The “variance” of these vectors is then used as the $D_n$-score rewiring metric. This variance is determined in the same fashion as scalar variance, except that the “mean” is the centroid point of the vectors. The Euclidean distance from each vector to the centroid is used as the “distance from the mean”. Using these substitutions, the formula for $D_n$-score is as below:

$$D_n - score = \frac{\sum_{i=1}^{n}[\text{distance}(V_i, \text{centroid})]^2}{n - 1}$$

where $V_i$ is each vector representing a node in each network, and $n$ is the number of networks being analyzed. If edge weights are supplied, normalization is performed before $D_n$-score calculation using the same method described previously for variance analysis. Edge weights are divided by the average (of non-zero values) across all networks.

26. In the “Node property” menu under “Multiple Network Analysis (Figure 8A), choose “DyNet REWIRING”.

7
27. In the “Edge property” menu, choose which attribute should be used as the edge weight to be analyzed. If unavailable, choose “present” to base the analysis only on edge presence/absence.

**Complex filtering**

*DyNet provides advanced filtering options that can hide nodes and edges much more efficiently than Cytoscape’s built in functionality.* Given that DyNet’s combined view may become extremely cluttered when simultaneously viewing many networks, it becomes extremely useful to be able to selectively hide and show certain network components based on a set of specific criteria. A tree of filters can be applied in complex combinations to all DyNet networks, automatically hiding any nodes and edges that do not meet the filtering criteria. AND, OR, XOR and NOT logical operators may be applied to different levels of the tree, allowing for complex filtering.

28. Under “Filter” in the DyNet panel, select the “+” button (Figure 8B).

29. Select a filtering option from the revealed “Choose column or create group…” menu.

*DyNet features network filtering options that make automatically hiding network components across all analyzed networks simple.* Filters are prefixed with either “Node:” or “Edge:” depending on what they apply to. Filters that begin with the name of a network after the prefix, such as “Node: Network1_Attribute” will apply only to the named network. Filters that begin with “ALL” will filter all networks separately using the same criteria, but will only display a node or edge in the DyNet Central Reference Network if the criteria are satisfied in all networks. Filters beginning with “EACH” behave similarly, but if the filtering criteria are satisfied in any of the networks, it will be displayed in the DyNet Central Reference Network.

Nodes and edges may also be filtered based on fold-change, variance, or Dn-score values, making it easy to identify nodes and edges that are significantly different or varying. This can be accomplished using the special filter options “DyNet Pairwise Comparison”, “DyNet Variance”, or “DyNet Rewiring (Dn-Score)”. This filtering will be updated dynamically if the attributes used to calculate them are modified.

30. (Optional) Select the “+” button again to add more filters, or select the “^” button to move the entire filter tree down one level.

*Nodes that are filtered out are still used in calculations for pairwise comparison, variance, and rewiring. If you wish to exclude nodes from these analyses, you must use the “Delete Filtered Components” option under the filter section (Figure 8B). This deletion can be undone using Cytoscape’s undo functionality (“Edit → Undo”).*

**Generating interactive heatmaps**
Heatmaps comparing edge attribute data in different networks can be generated from within DyNet. Edge data occupies the y-axis, and different networks are displayed on the x-axis.

31. Select the networks to be included within the heatmap under the “Heatmap” label using control (command for MacOS) + left click.

32. (Optional) Filter out any edges which should be excluded from the heatmap (See step 28).

33. Choose the edge attribute to be used for the heatmap under “Edge weight property”.

34. Choose either to cluster edges on values, or on their spatial proximity.

The spatial proximity option will enable clustering of heatmap rows by proximity in the DyNet Central Reference Network, rather than the default option of clustering by edge attributes. This will use the actual spatial distance between the midpoints of nodes, and result in the heatmap clustering to reflect node positioning in the network. This is most useful when used in conjunction with a layout algorithm that performs some kind of clustering. The clustered edges will also appear clustered in the heatmap, allowing easy identification of any unusual edges within clusters.

35. Click “Generate”. A new window containing the heatmap will open (Figure 9).

The heatmap window is interactive, selecting rows in the heatmap will select the corresponding edges within the network, and selecting network edges will result in the corresponding heatmap rows being selected. The heatmap window will remain on top of all other windows until it is closed by the user.

36. (Optional) Select a row by left-clicking, or multiple rows using control+click (command+click on MacOS) to select the corresponding edges in the network.

37. (Optional) Select edges within the network to see the corresponding rows selected in the heatmap.

38. Press Control + C (Command + C on MacOS) to copy the data from selected heatmap rows. The copied data can then be pasted elsewhere for further analysis.

SUPPORT PROTOCOL 1: INSTALLATION OF DYNET

DyNet is an application for Cytoscape 3.2+ (Shannon et al., 2003), which requires the Java 7+ runtime. In this protocol we document the options available for installing DyNet, as well as how to obtain Java 7+ and the Cytoscape 3.2+ platform, both of which must be installed prior to DyNet installation.
**Necessary Resources**

An internet-connected computer capable of running both Java 7+ and Cytoscape 3.2+.

**Protocol steps—Step annotations**

1. Download and install a Java 7+ runtime (the current Cytoscape version at the time of writing, 3.6, is compatible only with Java 8). On Windows or MacOS, navigate to Oracle’s download page (http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-2133155.html) and follow the download instructions.


**DyNet installation from within Cytoscape:**

3. Launch Cytoscape 3, and from the top menu bar select “Apps → App Manager…”

4. In the App Manager, search or scroll down to DyNet, then click “Install”.

**Automated installation from Cytoscape.org:**

1. Launch Cytoscape 3 and leave it open.

2. Using a web browser, navigate to http://apps.cytoscape.org/apps/dynet and select “Download”

3. Once complete, the webpage should show “Installed”

**Manual installation from file:**

1. Download the DyNet plugin jar file from http://apps.cytoscape.org/apps/dynet

2. Open Cytoscape 3, and select the App Manager (select “Apps → App Manager…”)

3. Select install from file and browse to the previously downloaded DyNet jar file.

**GUIDELINES FOR UNDERSTANDING RESULTS**

Once your networks have been imported and DyNet setup is initiated, you will be presented with a progress bar for DyNet initialization. This process will likely take a few seconds, but will depend on how many networks you have selected and how large they are. Once this process is complete, what you see next will depend on which version of Cytoscape you are using, as versions 3.4+ have an altered network view interface. In versions before 3.4, each network had
a manually resizable internal window within Cytoscape. DyNet was able to automatically lay out the windows such that the DyNet Central Reference Network appeared to the left, and all other networks in the analysis would be tiled next to it. In Cytoscape 3.4+, the internal window functionality does not exist, and so DyNet is unable to do this automatically. You will initially only see one network, the DyNet Central Reference Network. Fortunately, the newer versions offer an automated network view tiling function that can be used to achieve a similar result, as described from Step 12 of the main protocol.

Once you have all of the networks visualized simultaneously, you can manipulate these views using your mouse or touchpad, and will notice that when changing zoom levels, panning, or moving nodes around, that all of the views are synchronized, making comparison of differences far easier. If you have imported three or more networks (N > 2), you should immediately notice various nodes colored with different shades of red. This is the default behavior for performing node rewiring analysis when many networks are imported, using the D_n-score rewiring metric. The darker the shade of red, the stronger the rewiring. When analyzing many networks, you may choose to compare a particular attribute value. If this value is numeric, then its normalized variance across all networks will be used as the resulting score. This score is then used for highlighting the most variable nodes and edges within the DyNet Central Reference Network. Additionally, the score will be added to Cytoscape’s node/edge tables, where it can be utilized by other tools from within Cytoscape, or exported for use with external software packages. If a node/edge is missing an attribute value in a certain network, it will automatically be assigned 0. This means that any color highlighting will only produce sensible results for attributes in which higher values correspond to stronger/more significant results. Attributes containing p-values, or any similar metrics should first be transformed using the negative log or other methods. Additionally, normalization will only be applied to non-zero values to prevent missing values from resulting in a misleadingly high variance.

If you have imported exactly two networks (N = 2), you will initially see nodes and edges colored in either red or green. In this pairwise comparison mode, DyNet by default compares the presence or absence of nodes/edges in the 2 networks, highlighting only components that are unique to a given network. When using this pairwise mode you may also compare the two networks by node and edge attribute values, such as the node weight. In this case, the log_2 fold-change of the attribute value will be calculated and used as a score for determining node size and edge thickness within the Central Reference Network. This score will be available within the Cytoscape node and edge tables, and can be used for later analyses.

If during analysis you do not notice any highlighting, your networks likely all contain the same components and only vary by attributes. Ensure that your networks have varying components or attributes and that the correct attribute is enabled for comparison. You may also have encountered an issue with importing your networks, so ensure that each different network state you have imported has an attribute that can be used to identify corresponding nodes across all of the networks, and that the attribute is named in the same way in each individual network (refer to Step 8 onwards for how to choose different attributes).
COMMENTARY

Background Information

Networks of molecular interactions are not static entities, which presents a unique challenge for network visualization. Various software tools have previously attempted to tackle this problem, such as the DynNetwork application for Cytoscape (http://apps.cytoscape.org/apps/dynnetwork) which employs animation to show the differences between different conditions. This approach is not particularly effective when used with larger networks, and lacks any statistical measures to quantify network rewiring. An alternative Cytoscape application, kDDN (Tian et al., 2015), has a more advanced statistical approach but is limited to only comparing two network states. DyNet is a recently released tool (Goenawan et al., 2016) for Cytoscape 3.2+ that provides a wide array of tools capable of visualization and analysis of large multi-state dynamic molecular interaction networks. DyNet enables quantification of network features such as node rewiring that can then be reused in later analyses. It also allows users to visually compare and track nodes among multiple network states by keeping corresponding nodes and edges in the same place, even when users manually edit network layouts. Since the release of DyNet, new applications for dynamic network visualization have been released, such as DyNetViewer (Li et al., 2017), also available as a Cytoscape 3 app, which provides functionality for integrating static networks with time-course data (e.g. Static protein-protein interaction networks may be combined with time-course gene expression data).

Critical Parameters and troubleshooting

Potential issues and the recommended solutions are listed in Table 1. For general issues involving Cytoscape 3 itself, you may refer to Su et al., 2014.

It is most important to ensure that your naming conventions for nodes and edges are consistent between each individual network, as otherwise DyNet will be unable to correctly identify corresponding features in different networks. It should also be noted that hiding nodes and edges using the inbuilt filtering mechanisms will not exclude these components from analysis, only hide them from view.

ACKNOWLEDGEMENTS

The European Union Seventh Framework Programme (FP7/2007-2013) PRIMES project under grant agreement number FP7-HEALTH-2011-278568 provided funding for the research leading to these results.

LITERATURE CITED


**INTERNET RESOURCES**

Software download: http://apps.cytoscape.org/apps/dynet
Demonstration dataset:
https://bitbucket.org/dynetteam/dynet/downloads/EGFR_Inferred_Dynamic_Tissue_Interactions_Network.zip


Source code available from: https://bitbucket.org/dynetteam/dynet
FIGURE LEGENDS

Figure 1. DyNet initial setup dialog. Using this dialog, any previously imported network can be added to DyNet, and multiple attributes can be selected to use for the identification of corresponding network nodes and edges.

Figure 2. DyNet as it appears in Cytoscape 3.3 after initial setup. Views are automatically tiled, with the DyNet Central Reference Network taking up the majority of screen space.

Figure 3. How manual selection of network views must be done under Cytoscape 3.4+. In newer Cytoscape versions, DyNet cannot tile network views automatically. A) The “Show Grid” button, which will display all networks in a grid. B) All available networks displayed in grid mode. Multiple networks can be selected from the grid. C) The “Show View” button, which will tile and display all selected network views.

Figure 4. The Network View Synchronization Settings found in the DyNet main panel, featuring options to selectively toggle synchronization.

Figure 5. DyNet in pairwise network comparison mode. A) Pairwise network comparison settings in the DyNet control panel. Default settings are shown. B) The DyNet Central Reference Network displays unique nodes/edges in red or green, depending on which network they are found in. Shared nodes/edges are shown in white.

Figure 6. The DyNet Node Analyzer can be selected to focus analysis on a single node. Only immediate neighbours to the selected node will be highlighted.

Figure 7. DyNet running in node-analyzer mode. This mode highlights nodes and edges directly linked to the selected node (i.e. only its immediate neighbours), and reduces the visibility of all other network components.

Figure 8. The appearance of DyNet running in Cytoscape 3.4+ after the initial setup and manual tiling of views. Multiple network analysis mode is enabled.

Figure 9. Interactive heatmap generated within DyNet. Each row represents an individual edge in the network.
### TABLE 1

<table>
<thead>
<tr>
<th>Issue</th>
<th>Probable cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No nodes/edges are recognized as corresponding.</td>
<td>You may have not selected the correct attribute during setup.</td>
<td>Delete the central reference network (In the Control Panel change to “Network” tab, right click on “DyNet Central Reference Network” → “Destroy Network”, and restart DyNet (See Step 4 in main protocol). If this still fails, check that your corresponding components in the different networks have the same name.</td>
</tr>
<tr>
<td>No node or edge weighting is visible.</td>
<td>Pairwise comparison is disabled, or a non-numeric attribute has been selected for comparison.</td>
<td>Component weighting is only performed if both pairwise comparison is in use (See main protocol Step 18), and a numeric attribute is selected that a weighting can be calculated for. Ensure that either “Highlight Node Changes” or “Highlight Edge Changes” is selected under Pairwise Comparison, and under node or edge property select an attribute that consists of non-negative real numbers.</td>
</tr>
<tr>
<td>Performance when manipulating networks is poor, manual alterations are slow to register.</td>
<td>The size and/or quantity of networks synchronized is excessive.</td>
<td>You may improve performance by disabling automatic synchronization under Network View Synchronization in the DyNet control panel, see main protocol Step 17. Alternatively, if it is possible to use fewer/smaller networks for analysis this</td>
</tr>
</tbody>
</table>

### Zoom synchronization is enabled but does not always seem to work.

| The network being zoomed has not been selected. | For synchronization to work, the network being manipulated must be the currently active network, which can be achieved by left-clicking. Using the mouse wheel without first selecting the network by left-click will cause the zoom level to be altered without synchronization occurring in other networks. |

### Only the central reference network is visible.

| You are running Cytoscape 3.4+, and DyNet’s automatic view tiling is not available. | The views must be tiled manually, refer to main protocol Step 11. Alternatively, use Cytoscape 3.3. |

### Cytoscape freezes.

| Cytoscape is out of memory. | You may wait for Cytoscape to respond, or simply restart Cytoscape. To prevent this from occurring, you may wish to import fewer or smaller networks. The Cytoscape user manual [http://manual.cytoscape.org/en/stable](http://manual.cytoscape.org/en/stable) may assist in increasing Cytoscape’s access to memory. |
Figure 1. DyNet initial setup dialog. Using this dialog, any previously imported network can be added to DyNet, and multiple attributes can be selected to use for the identification of corresponding network nodes and edges.
Figure 2. DyNet as it appears in Cytoscape 3.3 after initial setup. Views are automatically tiled, with the DyNet Central Reference Network taking up the majority of screen space.
Figure 3. How manual selection of network views must be done under Cytoscape 3.4+. In newer Cytoscape versions, DyNet cannot tile network views automatically. A) The "Show Grid" button, which will display all networks in a grid. B) All available networks displayed in grid mode. Multiple networks can be selected from the grid. C) The "Show View" button, which will tile and display all selected network views.
Figure 4. The Network View Synchronization Settings found in the DyNet main panel, featuring options to selectively toggle synchronization.
Figure 5. DyNet in pairwise network comparison mode. A) Pairwise network comparison settings in the DyNet control panel. Default settings are shown. B) The DyNet Central Reference Network displays unique nodes/edges in red or green, depending on which network they are found in. Shared nodes/edges are shown in white.
Figure 6. The DyNet Node Analyzer can be selected to focus analysis on a single node. Only immediate neighbours to the selected node will be highlighted.
Figure 7. DyNet running in node-analyzer mode. This mode highlights nodes and edges directly linked to the selected node (i.e. only its immediate neighbours), and reduces the visibility of all other network components.
Figure 8. The appearance of DyNet running in Cytoscape 3.4+ after the initial setup and manual tiling of views. Multiple network analysis mode is enabled.
Figure 9. Interactive heatmap generated within DyNet. Each row represents an individual edge in the network.